[bookmark: _Toc22034053][bookmark: _Toc22034087]General Guidelines for Project Report Writing
This document provides general guidelines for your project report (Mid and Final) writing. Along with these guidelines, you are provided with two separate report templates for Development and Research and Development (R&D) projects respectively. These templates are a style guide for final year project reports. These styles should be used without modification or replacement. The project reports (Mid and Final) are a very important part of your project and its preparation and presentation should be of extremely high quality. Remember that a significant portion of the marks for your project are awarded for these reports. Your project reports (mid and final) should clearly highlight your efforts and contributions in achieving the goals and objectives defined in the project proposal. Both reports must follow proper formatting, citation, and clarity standards provided in this guideline. All the sections that are MANDATORY for your project report are listed at the end of this general guidelines document. It is recommended that you must follow the listed order to ensure logical flow to your writing. 
While this may well sound like a rather prescriptive approach to report writing, it is introduced for the following reasons.
1. The style guide allows students to focus on the critical task of producing clear and concise content, instead of being distracted by font settings and paragraph spacing. 
2. [bookmark: _heading=h.juiva58hvsia]By providing a comprehensive style guide the school benefits from a consistent and professional look to its internal project reports.
3. The style guide also allows the school to properly control the size restrictions that are placed on reports.
Page Layout & Size
The page size and margins have been set in this document (see Figure ‎1.1). These should not be changed or adjusted. Before starting write up, first, confirm that the template has the correct paper size. This FYP report template has been tailored for output on the A4 PAPER SIZE. Specify paper width according to dimensions shown in Figure ‎1.1 and ensure that the page margins are according to the margin values. 
[image: ]       [image: ]
[bookmark: _Ref80870615]Figure ‎1.1. Paper size settings defined for this document.
Throughout the report document, the font face “Times New Roman” MUST BE used for the text and font size of 11 MUST BE used. Line spacing for the entire document MUST BE 1.0 and paragraph spacing between two paragaphs within a section MUST BE 0 pt “Before” and 6 pt “After”. Distribute paragraphs text evenly between both margins to give the document a clean and crisp look, and this task can be performed by using justify paragraph option in MS word. The page size, fonts and spacing have been chosen to allow for approximately 700 – 800 words per page of text or approximately 25,000 – 28,000 per 35-page document.
In addition, page footers have been included in your report document. The footer should not need to be edited as it contains page number and date information that is always updated automatically.
Styles in Word
Every style defined in the report document is essentially a collection of formatting commands (font commands, paragraph controls etc) for each of the common types of components that are likely to make up your project report. As such the following standard styles have been defined:
· Normal – the style for the basic text of the document.
· Title – the main title style.
· Subtitle – the subtitle style.
· Author – the style used for the author’s name on the front page.
· H1, H2, H3 – styles for different levels of section headings.
· Figure – the style for a figure or table caption.
· Code – the style for program source code.
· Bulleted List – the style for a standard bulleted list such as this one.
· Numbered List – similar to the bulleted list style except that the list is numbered.
Normally, styles are selected from the Word style menu, which is located on the main Word toolbar (see Figure ‎2.1).
[image: ]
[bookmark: _Ref210127774]Figure ‎2.1. Selecting a heading style from the Word style menu.
It is important to emphasise that the above styles are the only styles that are approved for use in your report. Word comes with an expanded set of pre-defined styles and of course you can, in theory, define your own styles. However, we strongly suggest that you to stick to the approved styles. Of course, you may have a genuine need for a new style during the preparation of your report. However, we suggest that you consider whether one of the approved styles can be used before you rush to create a new style. 
Headings (16 Times New Roman)
[bookmark: _Hlk208054825]Your report will be structured as a collection of number sections at different levels of detail. Each level heading has been defined with a particular set of font and spacing characteristics. For example, the heading to this section is a first-level heading (it’s called Heading 1). Each section should start with Heading 1 having font size 16, bold, and font face “Times New Roman”. Heading level can be selected by clicking Heading 1 on the “styles” toolbar. All the sections that are MANDATORY for your project report are listed at the end of this guideline document.
Second Level Headings (14 Times New Roman)
Second-level heading have also been defined and can be accessed as Heading 2 styles. For example, the heading in this subsection is a second-level heading. Heading 2 should have font size of 14, bold, and font face “Times New Roman.
Third Level Headings (12 Times New Roman)
Third-level heading have also been defined and can be accessed as Heading 3 styles. For example, the heading in this subsection is third-level heading. Heading 3 should have font size of 12, italic, and font face “Times New Roman. In general, it is unlikely that fourth of fifth level headings will be required in your final report. Indeed, it is more likely that if you do find yourself needing them, then your document structure is probably not ideal. So it is recommended that the report should use a MAXIMUM of 3 level subheading. Subheading level more than 3 is strongly discouraged.
A Word on Numbering
You will notice that the main section headings in this document are all numbered in a hierarchical fashion. You don’t have to worry about the numbering. It is all automatic as it has been built into the heading styles. Each time you create a new heading by selecting the appropriate style, the correct number will be assigned. This form of automatic numbering is great when it works well, and while you are not responsible for the numbering itself, you are responsible for the correct use of heading styles. If you are not careful – for instance by setting a blank line to be a heading style – you will find headings to be numbered incorrectly. This is because the heading numbering works by counting the number of previous heading assignments (of a particular type – heading 1, 2 or 3) that occur up to a given point in the document.
Figures and Tables
Use the following instructions to create tables and figures. The table and figure numbering should be according to the chapters of the report. For example, the tables/figures in Chapter 1 will follow the numbering 1.1, 1.2, and 1.3 etc and the tables/figures in chapter 2 will follow the numbering 2.1, 2.2, and 2.3 etc. All the figures and tables must be cross-referenced in the text.  For example, Figure ‎1.1 refers to the to the paper size, and margins of the document. Similarly, all tables should be cross-referred in the text. For example, Table ‎4.1 shows the sources that can be used for literature review. Figure and Table labels and captions should be font size 10, “Times New Roman” and aligned middle. In this document a style called “caption” (accessed as usual from the new report style toolbar) has been defined for the figure and table captions. Figure captions should be below the figures; table captions should appear above the tables. Insert figures and tables after they are cited in the text. Use the abbreviation “Figure ‎1.1” and “Table ‎4.1”, even at the beginning of a sentence. Ensure that the figure and table are within the page margin mentioned in Figure ‎1.1. Once again, time has been spent defining this style to handle figure numbering, but care needs to be taken to ensure that extra lines are not carelessly created in this style or else the numbering will not be correct.
[bookmark: _Ref210376839]Table ‎4.1. Literature review sources

	Source 
	URL

	Scopus 
	http://www.scopus.com

	Springer Links
	http://www.springerlink.com

	IEEE Xplore
	http://ieeexplore.ieee.org

	Science Direct
	http://www.sciencedirect.com

	Google Scholar 
	http://www.scholar.google.com

	ACM Digital Library
	http://dl.acm.org/



Inserting and aligning figures and charts in Word can be a hit and miss affair at the best of times. As a tip, a fairly reliable way of inserting graphics and charts that have been copied to the clipboard is to use the “paste special” option in word and select a “picture” option, rather than pasting directly.
Figures, charts and tables should always be centred horizontally. This can be achieved by right-clicking the graphic, selecting the Format Picture option and then selecting the Layout tab to find various alignment options.
Program Code
A Code style has been prepared for formatting short excerpts of source code. It is a simple indented, single-spaced style using a fixed font (Courier New) to produce code that appears like the following:

static public void main(String[] args) {
  try  {
    UIManager.setLookAndFeel(UIManager.getSystemLookAndFeelClassName());
  }
  catch(Exception e) {
    e.printStackTrace();
  }
  new WelcomeApp();
} 

But it is strongly recommended to use pseudo code or algorithm rather to copy/pasting code from your system, especially for research and development projects. An example of the pseudocode is shown below.
[image: Algorithm 1 Pseudocode of the GWO | Download Scientific Diagram]
Table of Contents
A table of contents (TOC) page has also been included in the report template and can be created using the TOC generator in Word. The style of the TOC has already been set in the report template. To generate TOC, place the cursor position where you want to place the TOC, then click Table of Contents option in the References menu, and then click on TOC 1 option. This will automatically generate the TOC. Notice that you can update your existing table of contents by simply right clicking it and selecting the update field option.
A word of warning on this feature – the table of contents is automatically generated by compiling a table of all of the level 1, 2 and 3 headings in your document. This means that every line with one of these styles will appear in the table. If you use these styles for non-headings (of course you should not do this) then these non-headings will also appear in the table.
List of Tables and Figures
A List of Tables and List of Figures pages have been included in this report template and can be created using Insert Tables of Figures option in the References menu, and then using cation label for List of Tables and List of Figures respectively. To insert these lists, properly position the cursor after the headings on their respective pages of your report. Notice that you can update your existing table of contents by simply right clicking it and selecting the update field option.
References
[bookmark: _Hlk207983009]The Reference section is situated at the end of the report. It should follow IEEE references style, available in Microsoft word as shown in Figure ‎2.1, and display sources in the order in which they first appear in the document. Proper format should be following when citing journal acticles, conference papers, weblinks, technical reports etc.
[image: A screenshot of a computer

AI-generated content may be incorrect.]
[bookmark: _Ref207983239]Figure ‎2.1. Word references tab.
All sources used have to be APPROPRIATELY CITED THROUGH THE TEXT. It is necessary to study the structure of such work to write a strong final year project report. Moreover, a clear scheme will make a project report easier to read. 
The refernces used in the report must be cited in the text (e.g., introduction/background), also cross check if the refrence is same as cited in the text. You must display sources in the order in which they first appear in the document. For R&D projects: minimum refrences should be 10, and for development project minimum refrences should be 6.
We have not defined a specific style for the bibliographic entries that you will need at the end of your report. Instead, we strongly suggest the use of a numbered list style for your bibliography, with citations as shown in the sample text below.
Sample Text: For example Lau et. al. [1], explains the use Of VSP resource rooms to support group work in a learning environment. Hideyuki et. al. [2], propoosed FreeWalk: a supporting casual meetings in a network. For more details on how to add citations in a word document, you can visit the following links [3], [4].
	[1] 
	L. M. Lau, J. Curson, R. Drew, P. Dew and C. and Leigh, "Use Of VSP Resource Rooms to Support Group Work in a Learning Environment," Journal Paper Example, vol. 99, p. 2, 1999. 

	[2] 
	H. Nakanishi, C. Yoshida, T. Nishimura and T. and Ishida, "Freewalk: Supporting casual meetings in a network," in Proceedings of the 1996 ACM conference on Computer supported cooperative work, Boston Massachusetts USA, 1996. 

	[3] 
	G. Coach, "How To Reference In Microsoft Word 2025: Full Tutorial With Examples Of Citations & Bibliography," 2024. [Online]. Available: https://www.youtube.com/watch?v=wnviwr-CF2w&t=416s. [Accessed 23 6 2025].

	[4] 
	M. Inc., "Add citations in a Word document," [Online]. Available: https://support.microsoft.com/en-us/office/add-citations-in-a-word-document-ab9322bb-a8d3-47f4-80c8-63c06779f127. [Accessed 23 6 2025].





Mandatory Sections for Development based FYP-1 Project Report
Chapter 1: Introduction
1.1 Introduction
1.2 Problem Statement
1.3 Proposed Solution
1.4 Main Objectives
1.5 Assumptions & Constraints
1.6 Project Scope
1.7 Software Development Life Cycle Model 
Chapter 2: Requirements Analysis 
2.1 Literature review / Related Work
2.2 Stakeholders List
2.3 [bookmark: _Hlk210475133]Requirements Elicitation
2.3.1 [bookmark: _Hlk210475225]Functional Requirements
2.3.2 Non-functional Requirements
2.3.3 Requirements Traceability Matrix
2.4 Use Case Descriptions
Chapter 3: System Design
3.1 [bookmark: _Hlk210475525]Use Case Design
3.2 Activity Diagram
3.3 Sequence Diagram
3.4 Software Architecture Diagram
3.5 Class Diagram
3.6 Database Diagram
3.7 Collaboration Diagram
Chapter 4: System Testing
4 [bookmark: _Hlk210496087]
4.1 Test Cases Design
4.2 Unit / Integration / Acceptance Testing 
Chapter 5: Implementation (30 %)
5.1 [bookmark: _Hlk210496359]Work Breakdown Structure (WBS)
5.2 Team Roles and Responsibilities
5.3 Tools and Technologies
5.4 Implementation Details
5.5 Screenshots of Prototype / System
5.6 Challenges During Implementation
Chapter 6: Conclusions (FYP-2 Final Report Only)
5 
6 
6.1 Summary
6.2 Recommendations for Future Work
Chapter 7: References


For FYP-2 Final Report: Please revise Chapter 4 & 5 by considering 100% implementation and add Chapter 6 (Conclusion). 


Mandatory Sections for Research & Development FYP-1 Project Report
Chapter 1: Introduction
1.1 Introduction
1.2 Problem Statement
1.3 Proposed Solution
1.4 Main Objectives
1.5 Assumptions & Constraints
1.6 Project Scope
1.7 Software Development Life Cycle Model 
Chapter 2: Requirements Analysis 
2.1 Literature review / Related Work
2.2 Research Gap Identification
2.3 Requirements Elicitation
2.3.1 Functional Requirements
2.3.2 Non-functional Requirements
2.3.3 Requirements Traceability Matrix
2.4 Use Case Descriptions
Chapter 3: System Design/Methodology
3.1 Activity Diagram
3.2 Software Architecture Diagram
3.3 Database Diagram (ERD) – Optional
3.4 Dataset Details
3.5 Algorithm / Model Selection
Chapter 4: Implementation (30 %)
1. 
2. 
3. 
4. 
4.1. Work Breakdown Structure (WBS)
4.2. Team Roles and Responsibilities
4.3. Tools and Technologies
4.4. Implementation Details
4.5. Screenshots of Prototype / System
4.6. Challenges During Implementation
Chapter 5: Results & Analysis (FYP-2 Final Report Only)
5. 
5.1. Experimental Setup
5.2. Results
5.3. Comparitive Analysis with Existing Work
5.4. Discussion on Findings
Chapter 6: Conclusions (FYP-2 Final Report Only)
6. 
6.1. Summary
6.2. Recommendations for Future Work
Chapter 7: References


For FYP-2 Final Report: Please revise Chapter 4 by considering 100% implementation and add Chapter 5 (Results & Analysis) and Chapter 6 (Conclusion).
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Algorithm 1 Pseudocode of the GWO

set the maximum number of iteratio
Initialize the population X; (i = 1.2
Initialize a. A, and C
Calculate the fitness of wolves
Xq = the best search agent
Xp = the second best search agent
Xj = the third best search agent
while (1 < L) do

for each search agent do

Update the position of the current search agent by Eq. (5)

end for
Update a, A, and C
Calculate the fitness of all search agents
Update X . Xg and X5
t=1t+1
end while
return Xo
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